
Database Restructuring with the VARSTOCASES Command: 
‘Point and Click’ in SPSS 

 
In Appendix B, we presented the following hypothetical educational database: 
 

ID GENDER AGE1 AGE2 AGE3 AGE4 VERBAL1 VERBAL2 VERBAL3 VERBAL4 SCHOOL
1 1 60 90 117 144 3 6 4 5 1
2 0 63 99 120 138 2 2 3 1 1  

 
This example dataset is in a typical “multivariate” format most familiar to applied researchers: two students 
provided responses to ten variables. Responses for each student are contained in a separate row in the database, 
and each response variable has its own column. For multilevel analyses performed in SPSS, “stacked” database 
is needed where: 
 

• repeated measurements (i.e., Age1-Age4; Verbal1-Verbal4) are contained in 2 separate variable 
columns (i.e., Age, Verbal) 

• each individual (i.e., ID #1 and ID #2) is assigned a unique identification number separating the 
repeated measurements of each participant 

• a variable reflecting the timing of repeated assessments is created and included in the database. 
 
The following steps illustrate the process of restructuring a database from a “multivariate” to a “stacked” format 
in SPSS via the “point-and-click” interface using the above hypothetical educational data.  
 
Step 1: Assuming the above hypothetical educational data have been entered into SPSS, begin by clicking 
on the Data menu and selecting Restructure… as shown below. 
 

 
 
A selection window titled “Welcome to the Restructure Data Wizard!” will appear. This window gives 
researchers three database restructuring options: 

• Restructure selected variables to cases 
• Restructure selected cases to variables 
• Transpose all data 

 



In this example, only the selected variables Age1-Age4 and Verbal1-Verbal4 need to be restructured 
from a “multivariate” to a “stacked” format. 
 
Step 2: Click the option marked ‘Restructure selected variables into cases’ as shown below,  

then click  
 

 
 
The ”Restructure Data Wizard – Step 2 of 7” selection window will appear, titled “Variables to Cases: 
Number of Variable Groups”. This window requires the researcher to specify how many variables are to 
be “stacked”. In this example, two variable groups (Age1-Age4 and Verbal1-Verbal4) need to be 
restructured. 
 
Step 3: Click on the ‘More than one’ radio button, and type 2 in the ‘How Many?’ box as shown below.  

Then click  
 

 
 
The ”Restructure Data Wizard – Step 3 of 7” selection window will appear, titled “Variables to Cases: 
Selected Variables”. This window requires the researcher to:  

• Specify and give a new name to each variable group to be “stacked” 
• Specify how participant groups are to be identified 
 



Step 4a: In the ‘Variables in the Current File:’ window, select Verbal 1, Verbal 2, Verbal 3, and Verbal 4 
and move them into the ‘Variables to be Transposed’ window. Next, overwrite ‘trans1’ in the ‘Target 
Variable’ box by highlighting it and typing Verbal. The repeated measures of Verbal1-Verbal4 will now 
be “stacked” into a single variable column named Verbal 
 

 
 
Step 4b: Click on the ‘Target Variable’ window arrow , select ‘trans2’, and overwrite it with the 
variable name Age. In the ‘Variables in the Current File:’ window, select Age1, Age2, Age3, and Age4 and 
move them into the ‘Variables to be Transposed’ window.   
 
Step 4c: In the ‘Case Group Identification’ window, click on the window arrow  and choose the ‘Use 
selected variable’ option. In the ‘Variables in the Current File:’ window, select the variable ID and move it 
into the ‘Variable:’ window as shown below. These commands indicate that the ID variable will be used 
to separate the repeated measurements values (i.e., Age1-Age4 and Verbal1-Verbal4) of each participant. 

Then click  
 

 
 



The ”Restructure Data Wizard – Step 4 of 7” selection window will appear, titled “Variables to Cases: 
Create Index Variables”. In the “multivariate” format, each repeated measure (i.e., Age1-Age4 and 
Verbal1-Verbal4) had its own variable column. In the “stacked” database, the variables Verbal and Age 
created in the previous step now contain all repeated measurements. An index variable, containing values 
from 1 to 4, is needed to indicate each of the four repeated measurements. For example, a participant’s 
Verbal1 score would have an index variable value of 1; a Verbal2 score would have an index variable 
value of 2, and so on. 
 
Step 5: Click on the ‘One’ radio button when asked “How many index variables you want to create?”  
(In the article, we created one index variable called ‘Timevar’. This point-and-click method will create an 
index variable called ‘Index1’ by default). 

Then click  
 

 
 
The ”Restructure Data Wizard – Step 5 of 7” selection window will appear, titled “Variables to Cases: 
Create One Index Variable”. This window allows the researcher to specify the kind of values given in the 
index variable created in the previous step. The ‘Sequential numbers’ radio button option assigns 
sequential numeric values for the index variable; the ‘Variable names’ radio button option allows 
researchers to name (and give a label to) an alphanumeric value for the index variable. 
 
Step 6: The ‘Sequential numbers’ option is highlighted by default. The hypothetical educational dataset 
involves Age and Verbal data collected at four time points. So, ‘Index1’ will be a variable column having 
values from 1-4.  

So, just click  
 

 
 



The ”Restructure Data Wizard – Step 6 of 7” selection window will appear, titled “Variables to Cases: 
Options”. This window requires researchers to: 

• specify what is to be done with variables in the database not selected to be “stacked” in Steps 4a-c 
• specify how missing values are to be handled. 

 
Step 6a: In the ‘Handling of Variables not Selected’ option, we transposed Verbal and Age, but did not 
specify how SPSS should handle the remaining variables ID, GENDER, and SCHOOL. Select the ‘Keep 
and treat as fixed variable(s)’ radio button option to retain them in the database. 
 
Step 6b: In the ‘System Missing or Blank Values in all Transposed Variables’, this option asks how to treat 
missing data in the transposed variables (i.e., Age and Verbal). Select ‘Create a case in the new file’ to 
keep missing values in the database (e.g., see Peugh & Enders, 2004).  

Then click  
 

 
 
The ”Restructure Data Wizard – Finish” selection window will appear, titled “Finish”. To immediately 
restructure the database, select the ‘Restructure the data now’ radio button. To paste the syntax 
commands for Steps 1-7 and make modifications (e.g., change the name of the index variable to 
“Timevar”) select the ‘Paste the syntax generated by the wizard into the syntax window’ radio button. 
 
Step 7: Click ‘Restructure the data now’ 
 

 
 



Then click . 
 

 
 
The resulting database is similar (i.e., the index variable ‘Timevar’ was created with the syntax command, 
the point-and-click method assigns the index variable the name ‘Index1’ by default) to the database 
example in the lower portion of Appendix B generated via the SPSS VARSTOCASES syntax. 



Cross-Sectional Analysis with Level-1 and Level-2 Covariates:  
‘Point-and-Click’ in SPSS 

 
In the final cross-sectional model example, the group mean centered level-1 covariate cses and the level-2 
fixed-effect covariates meanses (i.e., average school SES) and sector (i.e., 0 = public school, 1 = Catholic 
school) were added to predict intercept and slope variability in the dependent variable mathach (i.e., mean 
mathematics achievement scores) using the ‘High School and Beyond’ data.  
 
The following steps illustrate the process of performing a cross-sectional multilevel analysis with level-1 and 
level-2 covariates in SPSS via the “point-and-click” interface using the ‘High School and Beyond’ database.    

 
Step 1: Begin by clicking on the Analyze menu and selecting Mixed Models, Linear as shown below. 

 

 
 



A selection window titled, “Linear Mixed Models: Specify Subjects and Repeated” will appear. This 
window requires the researcher to specify variables with correlated random effects. In the ‘High School 
and Beyond’ database, students are nested within schools. So students within the same school will have 
correlated responses (i.e., will have correlated random effects).  
 
Step 2: Select the variable school from the variable list window and move it into the ‘Subjects:’ window as 

shown below. Then click  
 

 
 



A selection window titled, ‘Linear Mixed Models’ will appear. Here the researcher specifies the linear 
mixed model to be analyzed.  
 
Step 3a: Select mathach from the variable list window and move it into the ‘Dependent Variable:’ window.  
 
Step 3b. Select cses (the level-1 covariate) and both meanses and sector (the level-2 covariates) from the 
variable list window and move them into the ‘Covariate(s):’ window. As discussed in the article, SPSS 
makes no distinction between level-1 and level-2 covariates. 
 
Step 3c: Click on the  button as shown below.    
 

 
 



A selection widow titled, “Linear Mixed Models: Fixed Effects” appears. This window requires the 
researcher to specify all fixed effects in the model to be analyzed. Three main effects (cses, meanses, and 
sector) and two cross-level interactions (cses*meanses, cses*sector) are specified.  
 
Check to ensure that: 1) the ‘Include Intercept’ checkbox in the lower left corner is checked, 2) the ‘Build 
terms’ radio button is selected, and 3) the window between ‘Factors and Covariates:’ and ’Model’ shows 
‘Main Effects’ as illustrated below. 
 

 
 



Step 4a: Select meanses, cses, and sector from the ‘Factors and Covariates:’ window and move them to the 
‘Model:’ window as shown below.  
 

 
 



Step 4b: Change the ‘Main Effects’ option in the middle window to ‘Interactions’.  
Include the two cross-level interactions (i.e., cses*meanses, cses*sector) to the ‘Model:’ window as follows: 

• select cses, press and hold the ‘Ctrl’ key, select meanses, click the  button 

• select cses, press and hold the ‘Ctrl’ key, select sector, click the  button 
 

Step 4c: Click , then click the  button. 
 

 
 



A selection window titled, “Linear Mixed Models: Random Effects” will appear. This window requires 
researchers to specify the variables that vary randomly in the mixed model. In the ‘High School and 
Beyond’ example, only cses is allowed to vary across schools.  
 
Step 5a: Check the ‘Include Intercept’ box, select ‘Main Effects’, then click on cses in the ‘Factors and 
Covariates:’ window and move it into the ‘Model:’ window as shown below. 
 

  
 
 
Step 5b: Click on school in the ‘Subjects:’ window under ‘Subject Groupings’ and move it into the 
‘Combinations:’ window as shown below. This indicates cses varies across schools. 
 

 
 
Step 5c: Click on the ‘Covariance Type:’ window at the top to change the ‘Variance Components’ default 
to ‘Unstructured’ as shown below.  
As indicated in the article, an ‘Unstructured’ covariance matrix means that intercept variance, CSES 
slope variance, and the covariance between the intercept and slope values are estimated. 
 

 
 

Step 5d: Click , then click the  button. 
 



A selection window titled, “Linear Mixed Models: Estimation” will appear. This window allows 
researchers to modify the estimation default settings.   
 
Step 6a: Since this analysis was conducted using maximum likelihood (ML) estimation instead of the 
default restricted maximum likelihood (REML; see Singer & Willett, 2003, pp. 87-90), click on the 
‘Maximum Likelihood (ML)’ radio button as shown below (All article analyses were performed with ML 
estimation). 
 

 
 

Step 6b: Click , then click on the  button. 
 
 
 
 
 



A selection window titled, “Linear Mixed Models: Statistics” will appear. This window allows researchers 
to control the printed output. 
 
Step 7a: Under ‘Model Statistics’ click the checkboxes for ‘Parameter Estimates’ and ‘Tests for covariance 
parameters’. These selections will print fixed effect estimates and standard errors, as well as significance 
tests for the variance components, respectively. 
 

 
 

Step 7b: Click  
 

Step 8: Click  

Estimates of Fixed Effectsa

12.11360 .1969132 162.972 61.517 .000 11.7247725 12.5024329

5.3379502 .3656776 153.728 14.597 .000 4.6155484 6.0603520

2.9393565 .1534947 140.203 19.150 .000 2.6358931 3.2428200

1.2169438 .3033674 152.323 4.011 .000 .6175930 1.8162947

1.0423705 .2960358 162.756 3.521 .001 .4578043 1.6269367

-1.64386 .2373583 145.075 -6.926 .000 -2.1129911 -1.1747369

Parameter
Intercept

meanses

cses

sector

meanses * cses

cses * sector

Estimate Std. Error df t Sig. Lower Bound Upper Bound

95% Confidence Interval

Dependent Variable: mathach.a. 
 



Estimates of Covariance Parametersa

36.72115 .6261133 58.649 .000 35.5142727 37.9690485

2.3188948 .3610217 6.423 .000 1.7090709 3.1463138

.1881010 .1985144 .948 .343 -.2009800 .5771821

.0652362 .2071072 .315 .753 .0001295 32.8717526

Parameter
Residual

UN (1,1)

UN (2,1)

UN (2,2)

Intercept + cses
[subject = school]

Estimate Std. Error Wald Z Sig. Lower Bound Upper Bound

95% Confidence Interval

Dependent Variable: mathach.a. 
 

 
This output matches the output produced by the SPSS MIXED syntax. 
 



 Longitudinal Analysis Testing the Error Covariance Matrix:  
‘Point-and-Click’ in SPSS 

 

The final longitudinal model presented in the article involved testing an alternate error covariance structure for 
Willett’s (1988) simulated data. Specifically, “opposites-naming” scores (i.e., Y), and a grand mean centered 
covariate (i.e., ccovar) were simulated at four time points for 35 cases. Briefly, testing an alternate error 
covariance structure examines whether all elements of the error covariance matrix need to be freely estimated 
(i.e., require an “unstructured” covariance matrix) or could be more parsimoniously modeled with a specific 
error covariance structure.  
 
The following steps illustrate the process of performing an alternate error covariance test in SPSS via the 
“point-and-click” interface using the Willett’s (1988) simulated database.    

 
Step 1: Begin by clicking on the Analyze menu and selecting Mixed Models, Linear as shown below. 

 

 
 

A selection window titled, “Linear Mixed Models: Specify Subjects and Repeated” will appear. This 
window requires the researcher to specify variables with correlated random effects. In Willett’s (1988) 
database, repeated measures are nested within individuals, and individuals are coded by ID. So repeated 
observations within each individual are correlated responses (i.e., will have correlated random effects). 
 
Step 2a: Select ID from the variable list and move it into the ‘Subjects:’ window as shown below. 
 

 



 
As discussed in the article, wave is a categorical variable that assigns an integer value to each repeated 
measurement (e.g., 1, 2, …, t, where t is the number of repeated measures). 
 
Step 2b: Wave is moved into the ‘Repeated:’ window as shown below. 
 

 
 
Step 2c: Select AR(1) (i.e., first order autoregressive) from the ‘Repeated Covariance Type’  window 

since it is the error covariance structure to be tested. Click  
 

 
 



The ‘Linear Mixed Models’ selection window appears that allows the researcher to specify the model to be 
analyzed. 
 
Step 3a: From the variable list, move Y to the ‘Dependent Variable’ window, and move time and ccovar to 
the ‘Covariate(s):’ window as shown below. 
 

 
 
Step 3b: Click on the  button. 
 



A selection widow titled, “Linear Mixed Models: Fixed Effects” appears. This window requires the 
researcher to specify all fixed effects in the model to be analyzed. Two main effects (time and ccovar) and 
one interaction (time*ccovar) are specified.  
 
Check to ensure that: 1) the ‘Include Intercept’ checkbox in the lower left corner is checked, 2) the ‘Build 
terms’ radio button is selected, and 3) the window between ‘Factors and Covariates:’ and ’Model’ shows 
‘Main Effects’ as illustrated below. 
 

 
 



4a. Step 4a: Select time and ccovar from the ‘Factors and Covariates:’ window and move them to the 
‘Model:’ window as shown below.  
 

 
 



Step 4b: Change the ‘Main Effects’ option in the middle window to ‘Interactions’.  
Include the interaction (i.e., time*cocvar) to the ‘Model:’ window as follows: 

• select time, press and hold the ‘Ctrl’ key, select ccovar, click the  button 
 

 
 
Step 4c: Click  
 
As stated in the article, the /RANDOM subcommand has been replaced by the /REPEATED 
subcommand already specified in Step 2. So the  button is skipped in this analysis. 
 
Step 4d: Click the  button. 
 



A selection window titled, “Linear Mixed Models: Estimation” will appear. This window allows 
researchers to modify the estimation default settings.   
 
Step 5a: Since this analysis was conducted using maximum likelihood (ML) estimation instead of the 
default restricted maximum likelihood (REML; see Singer & Willett, 2003, pp. 87-90), click on the 
‘Maximum Likelihood (ML)’ radio button as shown below (All article analyses were performed with ML 
estimation). 
 

 
 

Step 5b: Click on the  button. 
 
 
 



A selection window titled, “Linear Mixed Models: Statistics” will appear. This window allows researchers 
to control the printed output. 
 
Step 6a: Under ‘Model Statistics’ click the checkboxes for ‘Parameter Estimates’ and ‘Tests for covariance 
parameters’. These selections will print fixed effect estimates and standard errors, as well as significance 
tests for the variance components, respectively. 
 

 
 

Step 6b: Click , then click  
 

Estimates of Fixed Effectsa

164.3353 5.8127822 54.049 28.271 .000 152.6816396 175.9890136

27.19700 1.8467475 55.302 14.727 .000 23.4964855 30.8975068

-.0341955 .4720700 54.049 -.072 .943 -.9806193 .9122284

.4197220 .1499788 55.302 2.799 .007 .1191947 .7202493

Parameter
Intercept

time

ccovar

time * ccovar

Estimate Std. Error df t Sig. Lower Bound Upper Bound

95% Confidence Interval

Dependent Variable: y.a. 
 

Estimates of Covariance Parametersa

1188.100 225.9425 5.258 .000 818.4250679 1724.753689

.8182580 .0398242 20.547 .000 .7236762 .8826694

Parameter
AR1 diagonal

AR1 rho

Repeated Measures
Estimate Std. Error Wald Z Sig. Lower Bound Upper Bound

95% Confidence Interval

Dependent Variable: y.a. 
 

 
 
 
 


